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Introduction

1.Introduction

The module Map is providing an interface that allows the user a quick and easy transfer of geographic
data from any GIS (ArcGIS, MaplInfo, AutoCAD, Open StreetMap etc.) to the pipe inspection software
WinCan VX. No additional installation of a GIS or GIS component is therefore needed.

Map is installed together with WinCan VX on a computer located in a TV truck or in the office and is
activated by a license. Simply import the geographic data you obtained from your client (i.e. engineer
offices, pipe inspection companies, water authorities etc.) highlight the sections and manholes
displayed on the map with the mouse and finally transfer their content into the section and manhole
table of WinCan VX. A lot of typing work can thus be avoided and the risk of errors due to manual data
entry is significantly lowered too.

Map also allows creating new and correcting existing geographic data directly in the TV truck in order
you may directly hand out this updated data stuff to the client together with the inspection report.

If the manhole coordinates have been entered previously in WinCan VX the module Map will then be
able to automatically draw the network built by all the manhole and pipelines of your current project.

isdalizer %heap
Draw a pipeline netwerk base

W WinCan
Map

Georeferenced data
of roads, buildings,
ipe sections, manholes

Transfer data t

1.1 System requirements

e Windows 10 Pro and Windows 11 Pro; all the corresponding updates must be downloaded and
installed.

e Microsoft .NET-Framework 4.5 (latest version)

e Pipe inspection software WinCan VX (version 1.2025.17.1 or higher)
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Launching and quitting the application

2.Launching and quitting the application

The module MAP can easily be launched from the pipe inspection software WinCan VX hitting the
corresponding button in the vertical quick access bar to the left as shown below:

= WinCan VX - Analyst edition v2021.11.2.0 [Admin] - [Test WRC_UK] - [m] x
Projects. Printing Data Exchange Tocls Views Scoring Extended Modules Work Order Management Macros OEM Tools Admin @
- ) »
I~ =]
S®QO SO B[
Mew Open Close Refresh Manage Refresh Project
Project Project Project Project Projects  Llist | Participants
Manage Meta Dats
»  Test WRC UK | Sections | Laterals Nodes
Pipe Graph 2 % |[Sections 2 x [[Photo/Video 2 x
[€] P v Totalle v Town v Ro v Upstream v | Downstrea v (v Mat v DiaHeig v
WinCan VX
o e [ [ vt e e 0 [E] @] &) 2] (S [ -
7' Observations 1%
m+ ¥ m- ¥ C v Observation v Re v Contin v Struc v| Ser v| Photo v| Photo v|Clv Time Cou v Late v| Las v
=
=]
—
4
L
\'.
il cial
All new report templates were copied WRC_MSCC-4_ENG_UK_SECAWRC_MSCC4_UK  103.1GB local\WCSYS.db3 #DEMO-03832/L 0% 4

Next you will automatically be asked for the corresponding projection system (e.g. Switzerland =
EPSG:21781 or EPSG:2056; Germany = EPSG:4839 or EPSG:5243 etc.) as well as a geo-referenced satellite

image or map file the operator can use for spatial orientation:

# Map Wizard x Coordinate System X
Plan (®) Projected system:
| | [ H1503+ LV35 (epsq 2056) v
Copy plan to project folder O Fomrer TEEEE
Coordinate system CH1903+ (epsg:4150)
|CH1503+ epsg:4150) | | Sekect | .
() Tum off junknown system)

g-
Cance

If you haven’t got any geo-referenced map just continue with OK (1) and also turn off the projection

system (2) in case you don’t know it.
The main window then shows a default layout of the different working panels that can be modified and

saved at any time by the user.
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Launching and quitting the application

2.1 Main window
The main screen of MAP is subdivided into 3 areas:
1. Ribbon bar with corresponding command groups

2. Map panel to display the currently preferred geographic area: the data are shown (2a) as soon as
the corresponding object layers have been added to the map project hitting the command Home >
Add Layer (2).

3. Legend panel to show the content of the object layers based on SHAPE files and the WinCan layers
based on the data that have already been transferred into the WinCan project.

The legend (3) can be hidden automatically once the pin icon 1 has been activated (4) OR even
undocked from the main window to move it freely on any location on the current or a second screen:

wil®Bl: WinCanMapVX - Test_Biel_Center = o X
Home Tools Window [
g . ? Zoom @ Fi:'d i j@i Full o :} Lo‘(alize T Rectangle . N 4?- 'f' ? - a2
Gver @ Add Layer L @] @@\0 .$ Selected Solact » Point € Polygon “k SelectAll (e SN & o W -
- | RemoveLayd ~ 4| Previous | Next 57 Layer - G cicle @ ShowinVX ¥ DeselectAll - Bk s -

Layer Navigate | Select WinCan | Measure

WinCan Manhole Pat
WinCan Observations
‘WinCan Inspections
WinCan Manhole Observations
‘WinCan Manhole Inspections
WinCan Manholes
WinCan Sections |
biel_manholes | 2
biel_section

=]

KNKRRKRKRK

o
o

X: 585,536.66 - Y: 220,674.93

The main window appears in a medium size after the first launch of the application. Like all other
WINDOWS panels it can be minimized, maximized, enlarged and moved on a second (larger) screen to
improve the general view to the map when using the pan or zoom tools.
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Launching and quitting the application

2.2 Saving MAP projects

Click on the command File > Exit to quit the program. The various modifications of layer properties
within the current MAP project are NOT saved automatically. So always make sure you have manually
saved it before, using the command File > Save Project As:

f—

i New Project D:\Q5_WinCanVX_TestProjec..\Biel_Bienne.ttkproject

T OpenProject

Save Projd

Save Project As

{:’- Settings
"H’% Print

Projection System

Exit

You will then be asked to browse for the corresponding destination folder. It is recommended to use
the existing project subfolder \Module\Map where you may also store the SHAPE files provided by the
GIS managers (engineer offices, local water authorities):

M Save project as *
« v < Test_Biel_Center » Module » Map ~ [J] Search Map p

Organise ~ Mew folder SEE 0
Test_Biel_Center 2 Mame Date modified Type Size
DB | | Biel_Bienne.ttkproject 17/02/2020 17:36 TTKPROJECT File
Misc
Module
3D Confirm Save As

CleverScan

ElectraScan | Biel_Bienne.ttkproject already exists,

’ Do you want to replace it?
Inclination

Laser
Yes Mo
Pressure

Rehab
ScanEx

File name: | Biel_Bienne.ttkproject -

Save as type: Project file (*ttkproject) ~

+ Hide Folders Cancel

Also use the command File > Save Project As when you want to save modifications of layer properties
into the same project file in the future. The software then asks you directly whether you want to
overwrite the existing file. Confirm with Yes (1) to do so.
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Working with MAP projects

3.Working with MAP projects

MAP projects consist on a collection of geo-referenced records that are needed to build up the
pipeline network. These data records or layers are saved in different formats and are either used as
transfer layers or simply for spatial orientation.

A new MAP project is created and saved in the format ttkgp (ttkgp = tatuk-GIS). Existing project data
must be available in this format too in order you can open them in MAP.

r l
W | . 1) El | = WinCanMapVX - Durban_Isipingo = [=] £3
-
W F:\MAP_Projects\Biel\Biel ttkgp E 8
. New Project " . e &%
F:\MAP_Projects\MAP_DXF\Bad_Oeynhausen.ttkgp £ *; @
F:\MAP_Projects\Murten\Murten.ttkgp Shape '/_ &
T openProjec F:\MAP_Projects\Darwin\Darwin.ttkap - 2 % ctlc]
F:\MAP_Projects\Durban_ISIPIN.. \Durban_Isipingo.ttkgp Edit
Save Project
=] Sl

Save Project As

MAP project files contain the following important information:

e Layers representing sections and manholes based on original SHAPE files provided by a GIS
manager. Further layers representing streets, buildings, landscape elements etc. are optional and
mostly not available.

e WinCan layers based on object data that have already been imported into WinCan and that are
automatically created by MAP.

e Properties per layer that contain information about how to show the corresponding objects (i.e.
sections or manholes) on the MAP interface: sections and manholes can thus be displayed with
specific icons and labels.

¢ Display of frequently used queries as sub-layers:

1. Show sections ordered by diameter classes and displayed in specific colours

2. Show sections ordered by pipe material and displayed in specific colours

3. Show sections ordered by section type and displayed in specific colours

4. Show sections ordered by construction year and displayed in specific colours
etc.

Each sub-layer can thus be represented in the legend panel by its coloured icon
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Working with MAP projects

3.1 Layers

After adding the geographic data into a new project in MAP they are shown as so called drawing or
object layers that are precisely snapped to each other:

ol BN WinCanMapVX - Biel 0 [5] 3%
Home Tools Window WinCan @
o= @ 9 zoom @ Ful 0 “» Localize . Polygon z/ % Edit shape ¥ Draw Polygon
g Add Layer @ Pan , Selected '}. Point Q. Circle '//‘ Draw Point Draw Circle Snap to -
Layer View . Select | o Shape | : " : - 7 [
5 a Remove Layer = | Previous [P Next g Layer & B Rectangle S). Deselect All % # Drawline 3{. SplitbyLine @ |<
Layer Navigate Select Edit
Legend B x
[} biel_schacht
[7] biel_haltung
+ [ biel SAT
v biel |

Raster layer
(pixel based picture)™

Vectojtayer containing
sedtion informatioy

v

Vector layer
™ containing manhole
information

X: 581'972.42 - Y: 225219.37 . 4

There is a fundamental difference between raster and vector layers. Raster layers are based on pixel
data (i.e. pictures). Satellite or aerial view pictures, scanned plots etc. are good examples for this type
of layer. Raster pictures can only be displayed properly within a defined zoom range. When zooming in
close to an object every single pixel is simply enlarged and the picture will NOT be able to show you
more detailed information.

When available as vector layers on the other hand the data can be described with geometric forms
(i.e. vectors) like lines, triangles, rectangles etc. MAP is supporting different vector formats. Some of
them are needed for data transfer (e.g. section and manhole layers) whereas others just contain
information for spatial orientation (e.g. outlines of streets, buildings). Zooming in close to an object of
a vector layer will not create any loss of quality.

Important:

In order the different layers precisely snap together they need to be geo-referenced (i.e. ...calibrated
with a coordinate system valid for a given region...). This job has to be done by the GIS manager
(professional staff member of an engineer office or the local water authorities etc.).
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Working with MAP projects

3.2 Importing layers

The vector based layer data used in MAP are mostly available in the format SHP. These SHAPE files
only allow the storage of data that contain just ONE type of geometric shapes like:

e Polygones = outlines of streets, buildings, lakes, parks...
e Lines = sections, arrows for flow direction...

e Points = manholes, pumping stations...

Activate the command Home > Add Layer, select the files with the extension SHP in the dialogue box
that follows and click on the button Open to import them into the project. Multiple file selection is
possible too:

r

M| . ] E] | = WinCanMapVX
Home | Tools R x
o( )v| .~ Volume (F:) = MAP_Prajects + Durban_ISIPINGO ~ &3 | search burban_1sremGo \Q‘
E — Organize *  New folder B= = E:l .@-
LE}' = g Add LE}' = . MAP_Projects ;I Mame - |Date modified |Type
- E Remove Layer ::l:;z:f; || Manholes. xml 3/27/2012 4:27 PM XML Document
LE'}'EF | Attersee_AT =] Pipelines, xml 3/27{2012 4:23PM XML Document
| Aurolzminster AT 27/20 SHP Fi
Lﬂw'ﬂ o : : s o of
J Clermont
. Darwin
. Durban_ISIPINGO
. ETTER
. GemeindeRossbach_AT
. GemeindeSteinhaus_AT
. Geneve
. Gmunden_B145_AT
. Hautvully
. Kirchheim_AT
. MAP_DWG
| MAP_DXF
| MEREWENT x4l | |
File pame: |"sewer_pipes.shp” "sewer_MH.shp" j |Cnmmonﬁ|e;(*.ttkwp;*.cw;*.dj
Open I Cancel |
4
I

You may also directly move the SHP files from the Windows Explorer to the Map window using the
Drag & Drop functionality of your left mouse key.

Always check whether the SHAPE files are available as a complete file group that must contain at least
the following three files:

| | sewer_pipes.shp
| | sewer_pipes.dbf
| | sewer_pipes.shx

In order Map-VX is able to correctly display an object layer the SHP file itself is NOT sufficient; the
corresponding DBF as well as the SHX file are needed too!
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Working with MAP projects

3.3 Changing the layer order

Select the layer from the legend and move it upward using the Drag&Drop functionality of the left

mouse key: The displaced layer is thus covering those that lie underneath:

ol B | = ‘WinCanMapVX - Biel
—
é @ 5 zoom @ Ful o €. Loclize T Polygon ﬁ & editshape ® Draw Polygon
M Add Layer 3 selected ‘ €\ Point G cirde N *# Draw Point ® Draw Cirdle | Snap to
Layer View Select Shape
i & Remove Layer - | Previous [P Next | B Layer - T Rectangle S Deselect All = #_ Drawline 3 splitby Line | €4|€
Layer | Navigate | Select Edit
Legend R \
| flow direction 722,
[V biel_sections
v biel_manholes
[T biel_map 721
7
3718 3719
—
~ <~ w2~ o
a7,
3720
¥ 3714
o1
lsm 3716:<az12 13 /
< a4 322
-
~a b /
% \
715
M Rw E WinCanMapVX - Biel
e T
= @ S zoom @ Ful o ®) Localize T Polygon g} i editshape ® Draw Polygon
™ Add Layer L Pan i selected . Foint G circle *# DrawPoint ® Draw Cirdle | Snap to
Layer View Select Shape
- [ Remove Layer 5 l Previous | Next | B Layer - B Rectangle S). Deselect All - # Drawline S Split by Line C:‘H::l
Layer | Navigate | Select Edit
Legend 1% \
[V flow direction 722,
Iv biel_manhcles
[V biel_sections
[ biel_map 721
T
e 3719,
<
N e Iy
3717,
3720
¥ 3714,
3716,
Lﬁ 712 13 /
+ a7 o
<
~a ) /
3 \
715

3.4 Removinglayers

Select the command Remove layer in the context menu to the selected layer to remove it from the

current Map project:
dl B 1=k

Home Tools Window

- @ 2 @ Ful 0 €\ Localize €. Polygon

; % Add Layer e (@ {3 Selected ot & point G Circe

ayer | | d ele

2 & Remove Layer Next Layer e B Rectangle S) Deselect All
Layer Select

Legend

V' flow direction

[ biel_manholes Show properties...

V! biel_sections fhow data...
[ biel_map Save data...
Layer up

Layer down

& Edit Shape

»
- *# Draw Point

Shape

£ Draw Line
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Working with MAP projects

3.5 Modifying layer properties

The properties of each object layer can be modified in detail using the context menu command Show
properties for the selected layer. The following pages focus on the most important setting categories
(1) and their options (2) inside the properties dialogue that a user will usually apply in order to have the

layers shown as needed for the pipe survey:
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Vector: biel_section e ‘
b o X v A s TR
: -
= Change the name of the Iaygr i T . »
= Section 1 you want to have shown in - ’ @ Rom 9Fn @
Rend: r i ey
Li:: erer the Iegend panel (3)' :I o xoé Add Layer Vice l“ Pan @&Q);- Selected
Label = ‘i Remove Layer + 4| Previous | Next =¢..‘ Layer
Caption d
;}[;art |bie|_5ection | s Layes
Coordinate System v WinCan Manhole Parts
|UNKNOWN (epsg:0) | Select WinCan Observations
WinCan Inspections
WinCan Manhole Observations
" WinCan Manhole Inspections
The coordinate system must |en 1 2] WinCan Manholes
be provided by the SHAPE | | ® Other
files. If set to UNKNOWN you COnN
can select itin MAP directly. ® oD
- WinCan Sections
| - [ biel_manholes
Prefer styling from config file ] biel_section
] biel
Info
(= File: information ’f
Wizard ... QK Cancel Apply
Vector: biel_section e ‘
+ - W v a Visible whl®gs
General Line ; .
Sections Style Color Pattem Home Tools Window
[= Section 1 - o= Z @ Find Full
= [ m= L] (&, @i ew ew
i ) - Layer 4 View & Pan | 2
Label Width nbol Gap ymbol Rotate Z i Remove Layer + 4| Previous | Next :,“ Layer
g}[;art 2pt ~| | Opt 0 deg Layer Navigate
Smart size
mal WinCan Manhole Parts
1px > WinCan Observations
WinCan Inspections
Go to the category LINE to change ] WinCan Manhole Observations
the aspect of the section line you i
want to have shown on the MAP || ® Otrer
interface (1). CoN
Opt ~ @ NOD
WinCan Sections
] biel_section
(] biel
Wizard ... QK Cancel Apply



Working with MAP projects

The sub-category LABEL allows the user to have the corresponding object shown on the MAP interface
with the appropriate name.

Vector: biel_section e
+ - W v a Visible
General Value 2
Sections
= ecton 1 [IDNAME} / {MAT_E} ~
Renderer i i
L . .
s Select one or more GIS fields directly
et from the list. Text separators like “/” or
“_" can be typed manually.
[] Bald [ Undeline Shadow
[ talic [ Strikout
olor em
|D FFFFO0 v| | Transparent v| ‘ Home | Tools  Window
= z @ Find Full
Width Height Smart size = !E Skl E)E:r]n @@:‘“@ S
5 [2500twips v [250Dtwips  ~| [1px | Layer View Sheadei o
\3% Z i Remove Layer + 4| Previous |p Next :," Layer
Outline [ Layer Navigate [
Style Color Pattem gl_ Z—"
& W | oo o Mo | [Cse 1] 5
Wizard ... oK Cancel Aoply
Vector: biel_section e
+ - W v a Visible
Ll
General Label
Sections
) Section 1 Color Pattem
Renderer |D FFFFOD v| | Transparent v|
Line
Label Width Height Smart size
Chart [2500twips | [250Dtwips  v| [1px v
D
Outline
If you scroll down to the bottom
within the same category you may
define the postion of the text linked to
the corresponding object.
Alignment Label Rotate Position
% Flow
(= H [ Include in legend ‘
Wizard ... oK Cancel Apply

Hitting the Plus button at the top left of the properties dialogue, the user may subdivide the objects of
the current layer into different groups or classes and write the corresponding criteria like diameter,
section type/usage, pipe material, construction year etc. Objects that match the criteria are then shown
in specific colours and symbols which can also be displayed in the legend panel.

The following pages provide two examples how to write criteria (queries) correctly in order to have the

section groups subdivided into different diameter or pipe material classes and shown accordingly
on the MAP interface.
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Working with MAP projects

Example1: Show sections ordered by diameter class

Click on Sections (1) in the left part of the dialogue and hit the PLUS button (2) to add a new section
(object group). Next write the criteria for the different diameter classes as shown in the sample below
(3). Select colour and symbol (Line) that should represent the corresponding diameter class and
choose a caption (Label) that describes the objects accordingly (4).

WA biel SEC X
Visib PRO_HOEHE>=300 AND PRO_HOEHE<=450

FERIEE _ veomio ==

R— Section

11 [ Visible

=250

Minimum scale
=300 - 450 |

Fenderer
Line Maximum scale

Lo | ][]
an

][] IR

450 - 600 Render if match query (must be logical)
[FRC_HOEHE>=300 AND PRO_HOEHE<=450 e

[* 600 - 1000
= 1000

ok [ Caned | [ ey

The Map interface finally shows each pipe section in the specified color for the corresponding
diameter class it belongs to:

vIRER - WinCanMapVX - Test WRC4 = B 5%
Home Tools 3D Measurement Window L
E & Add Layer £ Zoom Q@‘ @ Ful @ @, Object  C, Polygon Z/‘ 7 Drawboint 7 @ ¥1 2 ” P
= o & > > ra "
[ Remove Layer il @ Find [\l Selected C,. Circle L Select All £ brawline ¥ ®& 3+ €] : wo
Layer View — 2 elect oz Draw = i 2 WinCan =
- + 4l Previous [P Next  ,”] Extents v ). Rectangle "} Deselect All ~ ¥ DrawCircle S# 2 @ | Co b

Layer Navigate | Select Edit Snap WinCan |

Layers.
[# [ WinCan 3D Measurements
[= 4] WinCan Nodes

@ Other

O CON
@ noD

WinCan Observations
‘WinCan Inspections
WinCan Sections & Laterals
[V biel_MH

(=) [ biel_SEC

<250

/ 300 - 450

/ 450 - 600
Save Data
/ £00: 00 Save Theme
>1000 Load Theme

Background Tiles

X: 58524042 - Y: 220.291.29

You may save this type of section display as a so-called THEME for further use. Just right click on the
section layer, hit the command Save Theme and type a sensible name for the new theme (e.g.
Sections_DIAMETER).
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Working with MAP projects

Example2: Show sections grouped by pipe material

Click on Sections (1) in the left part of the dialogue and hit the PLUS button (2) to add a new section
(object group): Next write the criteria for the different pipe materials as shown in the sample below
(3). Select colour and symbol (Line) that should represent the corresponding material and choose a
caption (Label) that describes the objects accordingly (4):

ar: hiel_SEC b

=% w|l& Visible Guery[ MAT_E=Cen tubes’ ]
R— Section
11 Visble
[ Asbestos ceme Minimum scale
Cast iron
@ Cement Caret | X
= Centubes Maximum scale
—== g %
Line
Lebel Render if match query logical)
Chart _ -
D I'u1_AT E="Cen tubes v|
Concrete Legend
Glass reinforced |Cer| tubes |
Palyvinylchloride

= )

Wizard ... QK Cancel Apply

The Map interface finally shows each section in the specified color for the corresponding material.

viER- WinCanMapVX - vxproject - a X
Home Tools 3D Measurement Window @
B & Add Layer Q £ Zoom Q@‘ @ Ful G &, Object G, Polygon ﬂ//‘ 7 DrawpPoint 7 @ %1 - A ” &
r— " c > r=a o) R J
i Remove Layer 5 # Pan ® Find | o Selected G, Circle B Select Al _4;’: Draw Line ¥ & = Cl 5 wo
Layer View = 2 elec ‘, Draw X A E WinCan
- - Previous Next 1,”I Extents - Dy. Rectangle *i Deselect All - 7/ Draw Circle < _& @ Co - %
) g
Layer | vigate | Select Edit Snap WinCan |

El 7] WinCan Nodes
@ Other

O CON

@ noD

WinCan Observations
WinCan Inspections
WinCan Sections & Laterals
biel_MH

&l [V] biel_SEC

Asbestos cement

Save Data
/ Cen tubes
Save Theme

/ foncrete Load Theme

f” Polyvinylchloride
Background Tiles

X: 585,845.49 - Y: 221,068.28

You may save this type of section display as an additional THEME for further use and select a sensible
name for the new theme (e.g. Sections_MATERIAL).
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Navigation tools

4.Navigation tools

Zooming in and zooming out the map view can easily be done with the mouse wheel. On the other
hand the command group Navigate in the ribbon bar provides additional buttons to control the
different map views:

vihEREI-
Home Tn:u:ula 3D Mfaement e Vindow

B Een £ zoom [@® 4 B Fun
s Remove Layer ‘u"ie?r 4 F'ane ® Fl'me[;! Selected

~ 4 Previous [P Next 1% Extents
Layer | avigate

1. Click on this button to open the map overview panel: the spatial extent of the whole map project
can thus be displayed in a small sized format below the legend. Simply zoom in the map within the
main window to get the currently visible area on the map highlighted by a red frame in the overview
panel. Then move the red frame to another location in the overview panel to get the corresponding
area shown and zoomed on the map:

viBR - WinCanMapVX - vxproject - =} X
Home | Tools 3D Measurement  Window ®
B Add Layer Dzoon @@ ¢ Brun Q 8, Object G Polygon Zf # DrawPoint % Draw Rectangle @ Rotste 31 VS
b Remove Layer Q 4 Pan ® Find [ )] Selected Ch circle ¥R Select Al =d 7 Drawline $ Draw Polygon 18 Rotate Scale 7% | €] o
Layer View o Select o Draw ‘- 200 Bz WinCan
2 + |4l Previous | Next 7] Extents + D) Rectangle ¥k DeselectAll ~ ¥ Draw(Circle G Invert Direction . RotateBend @ | C® B *

Layer | Navigate

Select | Edit 7 7 Snap

[] WinCan 3D Measurements
= 4] WinCan Nodes

® Other
O CON

@ nNoD

WinCan Observations

[ WinCan Inspections

[ WinCan Sections & Laterals
£1[] biel_MH

(e]
5[] biel_SEC

[~ Background Tiles

X:588,554.30 - Y: 223,928.76

2. Clicking this button is displaying the mouse pointer as a magnifier. The user is able now to draw a
rectangle on the current map view to have it zoomed in directly to the extent of that selection.

3. Move the current map view directly with the mouse within the map panel keeping the left mouse
key pressed.

4. Use the buttons Previous and Next to switch between map views you have already zoomed to before.
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Navigation tools

5. Hit this button to run the search dialogue below that provides a cleaned-up input mask for a quick
object search:

M Find Location *

Location Details [All Fields are Optional]

% Clear

Street | |

Housenumber | |

ZipCode | |

Town | |

Other Place | |

oo

6. This button group contains three possibilities, how objects selected in WinCan should be shown
and highlighted in Map (Select & Zoom, Select; Flash-up).

7. This button is zooming the map view in a way ALL object layers are displayed in the map panel at
their full extent.

8. This button is zooming to the area that contains the currently selected objects.

9. This button is zooming the map view to the object layer which is currently hightlighted in the
legend and displays it in the map panel at its full extent.
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Show object data

5.Show object data

The contents of the SHAPE files (i.e. geographic data) for sections and manholes can fast and easily be
called up. Map-VX is therefore providing the following two possibilities:

1. Showing all data of a specified object layer via the context menu command Show data.
2. Show the data of selected objects of a specified layer hitting the button

Y B - |+
Home Tools window WinCan
= @ }9 Zoom
= g Add Layer ) w Pan
Lavyer E Remove Layer View | Previous | Next
Layer Navigate
Legend a o
v pleile
v biel_schacht
v biel_haltung
[ biel Show properties...
show data...
Save data...
Layer up
Layer down

Remove layer

TYP_E

Sanitary water
SC_OBEN 3

5831201

‘WinCanMapVX - Biel = [5] £3
&
@& Full b Localize ¥ Polygon & £ Edit shape # Draw Polygon
i3 select [ Point G circle ': °# DrawiPoint Draw Cirde Snap to -
Sl
g Layer SEIECt [ Rectangle Sy Deselect All fDE # DrawlLine 3 Split by Line GEE=S
Select Edit
Info *
lof1 n
Shape.UID | Name Value =
14 ART sw
TYP_D Schmutzwasse
TYP_F Eauxus.es

\

X_OBEN
¥_OBEN 219957.04 o |t
SO_OBEN 4969
SC_UNTEN 203
X_UNTEN 58312464
¥_UNTEN 219953 05
SO_UNTEN 49667
PRO_ID 1
PROFIL Kreisprofil -
biel_haltung T =
_F TYP_E SC_OBEN ‘ | X OBEN Y_OBEN SO_OBEN | SC_UNTEN |X UNTEN *
X uS,e8 Sanitary water 34 58314558 219969.92 499.79 3482 h83z2228
| xuses Saritary water 58312228 213963.85 19768 M8 583120.1
_ us.es Sanitary water 219957.04
[ xuses Saritary water g 53347124 22015025 45781 146 53343244
| xuses Sanitary water | 3536 583189.08 219852.96 16273 1537 58321428
[ ccuses Saritary water | 3537 58321428 21983694 15146 5046 5832178 |
| uses Saritaywater | 3540 583513.19 22003061 14 147 533528 63
- I e A Sanitans watar ARTA REANRA RRI 719R77 949 AIR T IRTR RANGN OR _.ILI
X 583'109.88 - Y- 21597636 4

The user may drag these additionally displayed data panels either somewhere on the MAP-VX interface
(2) or pin it to one of the margins of the main window (1).
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Show object data

5.1 Looking for objects

Single sections or manholes as object layer elements can be found quickly when showing the data
table to the corresponding layer (1). Focus on the column containing the unique section or manhole
names, sort them either in the ascending or descending order (1) and highlight the record that you will
find after scrolling down the sorted list (2).

wheEH|- WinCanMapVX - Biel S 5
Home Tools Window WinCan @
E‘ @ ‘@ Zoom [P Next o 'y Localize 'i Polygon %\ # Edit Shape ® Draw Polygon
g Add Layer @ Full ‘}. Point O). Circle '_//" Draw Point Draw Circle Snap to -
Layer View = o Select Shape | y . i 2} B
s a Remove Layer b | Previous i.¢ Selected g Layer = W Rectangle cy Deselect All = # Drawline 3. SplitbyLine @ ‘—,-
Layer | Navigate | Select ‘ Edit |
= [T pfeile
[V biel_schacht
Iv biel_halung
v biel
X_OBEN Y_OBEN
5847456 220627.37
I /U Shape Feedback Off
“ Sanitary water 4an | Zoom to Shape 472 584753.67 2205:
| Sanitary water 472 Center on Shape B : 5054 584804.28 2205¢
H Sanitary water 476 Flash Shape 430.72 5056 584824 41 2205:
H
U Sanitary water 478 > 7 B 43074 479 584756.93 2206:
4 Fill Ctrl+F
u Sanitans water 479 I 2 420 AR 480 R24792 MR 2205
| < »
X: 584'725.85 - Y: 220'554.06 4

Finally right click on the highlighted record and select the command Zoom to Shape (3): Map-VX will
then zoom immediately to the corresponding object (section, manhole pumping station etc.) and show
its location directly on the map (4):
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Show object data

If you already know the exact expression of a section or manhole attribute (e.g. name or number of the
upstream/downstream manhole) you will be able to enter the value DIRECTLY in the dialogue shown
below. Select the command Select, Select by Attribute to open the search panel:

(WRw=ER = WinCanMapVX - Biel
] Home Tools Window
. 2 zoom @ Fun X lygon /~ Shift %/ send Map Position
A Add Layer @ U Pan {3 selected o ."‘- Localize fF Polygon kde | snapto - a /7~ Rotate 9, Position WinCan
LY | B Removerayer | VS | i previous ID Next | B Laver une | chlcl ACan | i caie & Fles Mep
Layer Navigate ‘* Point q. Circle i WinCan
'i. Rectangle "p Deselect All

Select by Attribute
rt Selection

Ert Selection

select by Attributes

 Layer
Mame: biel_manholes
™ Selection Only (Subselect)
— Field
[SCHACHTNUM |
— Camparison Operator
F =l
—Value
f470
Select Foom Select Cancel
(X 58TV 2R
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Transfer object data into WinCan VX

6.Transfer object data into WinCan VX

Data transfer is one of the most important functionalities in Map-VX. Master data for pipe sections and
manholes can be indicated quickly, simply and flawlessly when importing them directly from GIS
systems which they are managed in. Subsequently typing errors are excluded and the operator can
focus on the current survey job.

Via the button the user can quickly access all GIS data linked to the selected object (pipe section or
manhole) and therefore is able to detect the GIS fields containing data that eventually will have to be
transferred to the pipe inspection software WinCan VX.

6.1 Field mapping

Before GIS-data can be transferred into WinCanVX, each GIS field needs to be mapped or assigned
manually to the corresponding WinCan field. The most important section/manhole fields are listed
below:

OBJ_Key -> Section/Manhole Name (unique name to identify the section/manhole)
OBJ_Length -> Section length (distance from Upstream Manhole to Downstream Manhole)
OBJ_DepthTolnvert  -> Depth of the manhole (distance from cover to bench/channel)

OBJ_City -> Name of the City/Town where the section/manhole is located

OBJ_Street -> Name of the Street where the section/manhole is located

nodeFromKey -> Name of the Upstream Manhole

nodeToKey -> Name of the Downstream Manhole

OBJ_Shape -> Shape of the pipe (circular, rectangular, egg-shaped etc.)

OBJ_Size1 -> Diameter/Height of the pipe [mm]/ [inch]

OBJ_Size2 -> Width of the pipe [mm] / [inch]

OBJ_Material -> Material of the pipe (concrete, steel etc.)

OBJ_SectionType -> Type of section (wastewater, stormwater, mixed water)

OBJ_Usage -> Type of section (replaces OBJ_SectionType in some standards)

OBJ_WasteWaterType -> Type of section (replaces OBJ_SectionType in some standards)

The manhole coordinates are transferred automatically from the SHAPE files and do not need to be
included in the field mapping.

To start with the field mapping select an object layer and call up the menu command Home > WinCan
> Edit Mapping:

v . - r1 i WinCanMapVX - Test_Biel_Center
m Home Tools Windo
= 9 J» Zoom ® Find @ Full O €. Localize ¥ Rectangle v 'Y
A Add Layer W Pan 8| @8- (.} Selected €. Point € Polygon i QR e
Layer | — View Select WinCan i
+ | Remove Layer + | Previous [P Next 57 Layer + S Circle @) Showinvx = @ Vx /1~ S
Layer Navigate Select Edit Mapping
Transfer to WinCan

Reset Transformation

The following page provides a sample of a standard mapping for the transfer of section and manhole
data. Select the GIS field that matches the corresponding WinCan field in the right part and click on
the button Add in order to set the field assignment in the left part of the dialogue box. The names of
the WinCan fields are taken directly from the template used in the current project.
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Transfer object data into WinCan VX

Especially note the field assignments highlighted in red that are mandatory for a successful transfer.

field mapping sample for sections:

# Edit WinCan Mapping - biel SECwincanxml <@ == The field mapping for each layer is saved as an XML file
(*.wincan.xml) in the project subfolder \Module\Map
together with the shape files.

“3 =
w8
Field Mapping
Type I|sedions le
WinCan Map < Add
Cty 10BJ Cty) cry Remove >
Construction date {OB... | BAUJAHR

Material (OBJ_Material) | MAT_E
Shape (OBJ_Shape) PRO_E

Size 1 ({OBJ_Size) PRO_HOEHE
Size 2 (OBJ_Sized) PRO_EREITE
Street (OB.J_Strest) STR_OBEN_E
To node key (nodeTo... | SC_UNTEN
Usage ({OBJ_Usage) TYP_E

WinCan Fields Layer Figlds
From node id (OBJ_FromMode_REF) & | |MAT_ID -
Group (OBJ_Group) MATERIAL
Group number (OBJ_GroupMo) NAME
14 (OBJ_PK) PLAM_CBEN
Locality (DBJ_Locality) PLAM_UNTEN
Mema (CBJ_Mema) PRO_F
Ownership (OBJ_Ownership) PRO_ID
Pipe length (OBJ_PipeLength) PROFIL
PLR suffix (OBJ_PLRSuffix) RAUIGKEIT
Frofile (OBJ_Profile) S0O_OBEN
Real length (OBJ_Reallength) SO_UNTEN
Renew date (OBJ_RenewDate) STADT
Shape WKT (OBJ_Shape WKT) STR_OBEN
Sort arder (OBJ_SortOrder) STR_OBEN_F
Spare 1 (OBJ_Sparel) STR_UNTE_E
Spare 10 (OBJ_Spare10) STR_UNTE_
Spare 2 (0BJ_Spare?) STR_UNTEN
Spare 3 (OBJ_Sparel) TYP_D
Spare 4 (OBJ_Spared) TYP_F
Spare 5 (0OBJ_Spareh) ¥_0OBEN
Spare & (OBJ_Sparek) X_UNTEN
Spare 7 (OBJ_SpareT) Y¥_OBEN
Spare 8 (0OBJ_Sparel) ¥ Y_UNTEN hd

9~ B

Field mapping sample for manholes:

M Edit WinCan Mapping - biel_MH.wincanxml ‘ -—

w < E
Field Mapping
Type '|manhole5 vll
< Add
Remaove =

MNode Type (OBJ_MNod... | TYP_E

Street {OBJ_Street) STRASSE_E

- m}

Available Fields

WinCan Fields Layer Fields

Diepth toinvert (OBJ_DepthTolnvertly & | | DECKEL Z

Group (OBJ_Group)

Group number (OBJ_Groupho) PLAMN_GEP

Id (DBJ_PK) SOHLE_Z

Locality (OBJ_Locality) STRASSE_D

Material (OBJ_Material) STRASSE_F

Meme (OBJ_Mema) STRASSE_ID

Mumber (OBJ_Mumber) TYP_ID

Ownership (OBJ_Ownership) TYP_TEXT

Shape WKT (OBJ_Shape_\WKT) X

Size 1 (OBJ_Sizel) Y

Spare 1 (OBJ_Sparel)
Spare 10 (OBJ_Spare1l)
Spare 2 (OBJ_Spare?)
Spare 3 (0OBJ_Spareld)
Spared (0OBJ_Spared)
Spare 5 (OBJ_Spareh)
Spare 6 (OBJ_Spareh)
Spare 7 (OBJ_SpareT)
Spare 8 (OBJ)_Sparel)
Spare 9 (0OBJ_Sparel)
System (OBJ_System)
Type (OBJ_Type)

2~ B

Existing field mappings can be re-used for other projects. So simply select the corresponding file

*wincan.xml.
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6.2 Selecting and transferring objects

Choose a selection mode directly via the ribbon bar (e.q. circular selection) and highlight the objects to
be transferred on the map (1).
dl B 1=1 WinCanMapVX - Biel
Home Tools Window
P zoom @ Fu
= A Add Layer @ ; i3 ;:Lmd seg

| W Pan
Layer View
= i Remove Layer o | Previous [P Next Layer

Layer | Navigate Select

= o = 1

€ Localize ¥ Polygon > | Editshape ® Draw Polygon
/4
€ point |G carcle} %/ Draw Point @ Draw Circle
n e Shape | . . - :
- Rectangle ytg)ect All Z Z_ Drawline S Split by Line
| Edit

Y

WinCan

Snap to
chiel

[ flow direction
[V biel_manholes
IV biel_sections
[V biel_map

To select objects separated from each other activate the point selection and keep the CTRL key pressed.
The command Deselect All (2) discards every selection. The colour for the selected objects can always
be customized via the command File > Settings > Map:

" LIZIE
Mew Project GAMAS W WinCanMap Settings ™
GAMAR
F inCan ap tartup ort ap Tiles ode Templates
W Open Project WinCan M 5 Eq Map Til Mode Templ
| 2 . Selection Style DK
i Save Project
Color: Select
Save Project As - mCancel
______________________________ Opacity (%) 75
L3 serings N

= . -
oot Map Background
Projection System Color: |:| Select

Ch\Users\Public\Documents\CDLAB\WinCanMapVXAWinCanMapVX xml
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Transfer object data into WinCan VX

The data transfer from MAP is only possible if a new project has been created and opened in WinCan
VX first. Next select the sections you want to have transferred into WinCan VX, right click somewhere
on the map and hit the context menu command Selection to WinCan. Check both options (1) in the
dialogue box below, set the connection points direction to Downstream (2) and launch the data transfer
(3). The progress finally is displayed in a separate information box:

adil 2= 15 WinCanMapVX - Biel
File Home | Tools Window
= @ 2 zoom @ Full 0 €\ Localize ¥ Polygon %~ % Edit Shape ® Draw Polygon N
‘g Add Layer « w Pan .} selected €\ Point Loy Circle} %/ Draw Point ® Draw Circle Snap to -
Layer View Select r = Shape 3 . WinCan
B i Remove Layer v | Previous [P Next g Layer 4 » Rectangle €\ Deselect All = #_ Drawline . Split by Line C:h(:l X
Layer | Navigate Select Edit

b — L 1 &4
[ flow direction kY
[V! biel_manholes
v biel_sections
V! biel_map

M Transfer to WinCan

18 sections are ready for transfer to WX

Shape files doesn't contain Z coordinate
Generate missing nodes
0 Mark shape as fixed

Section points direction Downstream o ~

(® Take Z coordinate from shape
Take Z coordinate from field STADT

Copy
Paste
Selection to WinCan
Filter in WinCan

| \ A 4028 N
O | g, :E\\ \" /S yw»
eTrana‘er mCancEl \V‘ 530 = .!.‘ f' .‘ .
| . 4 g 2 " m .

e )
- -

pf
e

-y .

Once objects have been transferred you may follow the inspection progress if you copy the shape files
as well as the MAP project file (*.ttkgp) into the subfolder \Modules\Map of the current project and set
this one as a Startup folder:

M| . ] E] |5
. Mew Project GAMAR M WinCanMap Settings Y
GAMAR
ri Open Project WinCan Map  Statup Bxpot Map Tiles Node Templates
3 o G-
t Save Project Use Startup Project

Save Project As Startup Project njects\Test_US_PﬂtCP\Module\Map\BieI_Bienrle.ttkgp| fi mCancel

Print

Projection System

I L

C\Users\Public\Documents\CDLAB\WinCanMapVX\WinCanMapVxxml
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Transfer object data into WinCan VX

From now the data provided by the Map project (*.ttkgp) are launched automatically as soon as the
user hits the button *# from the WinCan project that may already contain previously transferred data:

I= WinCan VX (-PROD-) v1.1.2017.3 [Admin] - [Test_US_PACP] - o x
Projects  Printing  Databxchange  Tools  Views  WinCanAnalyst  Extended Modules  Work Order Macros @

»

Work Order "-Job 1-°, Number , Alternative "Variant 1"

Test USPACP | Sections  Laterals  Nodes

Pipe Graph 7 X |[Sections 7 % [[Photo/Videa 7 x
521 4 1SWCDC5 1920 Homelown  Fairlie Gardens 529 EXRE) Concrele
5 RWcd2 1300 Hometown  Fairclough Streel 3422 B S04 Concrete
050 & 2RWed 1 2860 Hometown  Fairclough Street 3421 B 2 Centubes
7 1SWcDB2 T 1670 Hometown  Eagle Close 4028 EIE Conerete .
& 1SWCD5 1900 Hometown  LaconTemace 517 5 s Concrete WI n c a n
9 RWed3 1300 Hometown  Fairclough Street 3422 5 505 Conerete
10 1SWCDB1 2400 Hometown  Eagle Close 4027 S 408 Conerete
[ERY 1SWCDB6 7480 Hometown ' Eagle Close 1524 1523 Concrete
12 1SWCDC8 2800 Hometown  HalefieldRoad 521 EXED) Concrete
13 1swen4 T 7io Hometown  Haggerstone Pla.. 631 o 57 Gonerete
14 1SWCDE 8370 Homelown  Haggerstone Pla. 5341 > 56 Cement
15 1SWCDCY 650 Hometown  HalefieldRoad 520 B 5 Concrete
16 1SWCDC7 3590 Hometown  Failie Gardens 522 5 51 Conerete
17 1SWCDC6 3810 Hometown  Fairlie Gardens 530 2 = Conerete
12 1SWCDB9 1760 Hometown  LelehamRoad 3423 B 517 Concrete v
[ - ) ] (1] o 8 7 W 1 il
Observations B33
No data present

@& 7 u
NASSCO_PACP-6_ENG_USA_SEC/IPACP-§ 242 GB locallWCSYS.sdf #DEMO-3433265141L 0%
WinCanMapVX - Test_Biel_Center - m] X
Window @
@ D Zoom @ Find @ Ful €. Localize T Rectangle w 7Y i )
LS I o0 13 € poi o ] . B 2 &
Add Layer Pan o Selected Point Polygon G
A y R @@ fs ST b Polyg % inen & e S0 Lo
B Remove Layer ~ | Previous | Next 57 Layer - G cicle @) ShowinVX - B sss &
Layer | Navigate |
Layers |
p—
WinCan Manhole Parts
[ WinCan Observations
[4] WinCan Inspections

WinCan Manhole Observations
[4] WinCan Manhole Inspections
|+ /] WinCan Manholes

[ WinCan Sections

biel_manholes
[ biel_section

[ biel

The red layer
group (1) is
created by
WinCan whereas
the blue layer
group (2) shows
the original
section and
manhole data
provided by the
shape files.

X: 585,052.41-Y:220517.76

So the user is able to see at one glance the sections, which have already been transferred and are now
ready to be inspected (1) and the sections yet to be transferred if ever needed (2).

Page 24/48



Transfer object data into WinCan VX

6.3 Showing objects in Map

You can subsequently highlight any transferred record in WinCan VX and the software automatically

jumps to the corresponding pipe section or manhole in Map:

(VK

»

Printing

WinCan VX (-PROD-) v1.1.2017.3 [Admin] - [Test_US_PACP]

Data Exchange Tools Views WinCan Analyst Extended Modules Work Order Management Macros

Work Order "-Job 1-", Number , Altemative "Variant 1"

Test_US_PACP | Sections Laterals Nodes

[] WinCan Manhole Parts
[ WinCan Observations
[ WinCan Inspections

WinCan Manholes

[] WinCan Manhole Observations
[] WinCan Manhele Inspections

WinCan Sections

biel_manholes
biel_section

HEEIE

i§]
z

X: 585,217.41 - Y: 220,543.29

Pipe Graph 1 X ||Sections 3%
'PipeSegme v Totallen « Gty ¥ Steet ¥ Upstream 2
| e | | - B B —
524 4 1SWCDC5 19.20 Hometown Fairlie Gardens 529 => 530 Concrete
5 2RWcd 2 13.00 Hometown Fairclough Street 3422 = 5004 Concrete
. 0.00 6 2RWed1 2860 Hometown Fairclough Street 3421 = 3422 Cen tubes
. 7 1SWCDB2 16.70 Hometown Eagle Close 4028 = 524 Concrete
g 1SWCDS5 19.00 Hometown Lacon Terrace 517 > 5341 Concrete
9 2RWcd 3 13.00 Hometown Fairclough Street 3422 = 5005 Concrete
i 1SWCDB1 24.00 Hometown Eagle Close 4027 = 4028 Concrete
1 » B 74.80 Hometown H 15w : Concrete
12 1SWCDC3 28.00 Hometown Halefield Road 521 = 520 Concrete
13 1SWCD 4 7110 Hometown Haggerstone Pla.. 631 = 517 Concrete
14 1SWCD &6 83.70 Hometown Haggerstone Pla.. 5341 = 56 Cement
15 1SWCDC9 6.50 Hometown Halefield Road 520 => 5341 Concrete
16 1SWcCDC7 35.90 Hometown Fairlie Gardens 522 = 521 Concrete
17 1SWCDC6 38.10 Hometown Fairlie Gardens 530 = 522 Concrete
12 1SWCDB S 17.60 Hometown Laleham Road 3423 = 517 Concrete hd
| o il amsl
Observations
T T T T S TS S S M T
No data present
wReg = WinCanMapVX - Test_US_PACP - m] X
Home Tools Window o
@ P Zoom @ Find @ Ful ® Localize @ Showin VX %\ &z Y W &y
Ui e - oy
e A Add Layer e @@ e TR POt G Circle V& . @ T ‘m
- & Removelayer + | Previous |P> Next [ Layer + B\ Rectangle ) Deselect All - Z % il = T & s
Layer ‘ Navigate WinCan | Measure
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6.4 Showing objects in WinCan VX

You may also highlight the objects in Map-VX first and have them shown in WinCan VX immediately.
Mind that the button ¥ is activated for that purpose.

Next select any section in Map-VX and WinCan VX highlights the corresponding record directly in the
section overview of WinCan VX.

[ winCan Observations

[ WinCan Inspections

[ WwinCan Manhole Observations
[#] WinCan Manhole Inspections
‘winCan Manholes

<]

WinCan Sections

=
[ biel_manholes
[ biel_section
[ biel

X: 585,225.84 - Y: 220,542.38

Select

F=TCo. A

vk

Wil

nCan VX (-PROD-) v1.1.2017.3 [Ad

A B 1=1E WinCanMapVX ~ — m] X
File H Tool: Wind N N 2
ome oo mpuw ° o . Localize 0 Show in VX ey 5
= Zoom Find @ 4 @ %/
= KR o e ) & : w b
Add L 4 I Point q; Circle e @ 2 -
Layer o =i View Q 4 Select Draw 7Y WinCan f“ G B
- B Removelayer | .l Previous I Next +~ W Rectangle ) Deselect All - 2 xcflcl - E&s
Layer ‘ Navigate Edit ‘ WinCan ‘ Measure ‘

 PACP]

Projects  Printing DataBxchange  Tools  Views  WinCan Analyst Extended Modules Work Order MaYagement Macros
i Work Order "Job 1-", Number , Alternative "Variant 1"
Test US PACP | Sections | Laterals  Nodes
Pipe Graph 1 X ||Sections nox
Stree Downstrea 7 Material 7
PipeSegre v Tellen ¥ Gy ¢ Suest ¥ Ussteam ¥ ¥ \ [Shep = &%
522 5 2RWcd 2 13.00 Hometown Fairclough Street 3422 = 5004 Concrete
6 2RWed1 28.60 Hometown Fairclough Street 3421 2 22 Cen tubes
0.00 7 1SWCDB2 16.70 Hometown Eagle Close 4028 E3 524 Concrete
g8 1SWCD 5 19.00 Hometown Lacen Terrace 517 = B3 Concrete
g9 2RWcd 3 13.00 Hometown Fairclough Street 3422 = 5005 Concrete
10 1SWCDB1 24.00 Hometown Eagle Close 4027 > 4028 Concrete
1 1SWCDB 6 74.80 Hometown Eagle Close 524 E3 523 Concrete
12 1SWCDC8 28.00 Hometown Halefield Road 521 E 3 520 Concrete
13 1SWCD4 71.10 Hometown  Haggerstone Pla_ 631 2 517 Concrete
14 1SWCD 6 8370 Hometown  Haggerstone Pla. 5341 2 56 Cement
15 1SWCDC9 6.50 Hometown Halefield Road 520 = 5341 Concrete
i3 1swcDC7 .9 {Hometown | Fairlie Gardens Concrete
17 1SWCDC& 3810 Hometown Fairlie Gardens 530 El 522 Concrete
18 1SWCDBS 17.60 Hometown Laleham Road 3423 E3 517 Concrete
v
l ol i@y aEs
Observations
T TS T e

No data present
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6.5 Showing filtered objects in WinCan VX or Map

All objects transferred to WinCan VX (pipe sections and manholes) can be highlighted and then filtered
directly via MAP.

Highlight a section group in MAP for that purpose using the point selection tool and keeping the CTRL-
key pressed. Next right click on the map area and select the context menu command Filter in WinCan:

LAl B J=1E WinCanMapVX - Test US_PACP - 0o X
Home Tools Window ®
= @ B Zoom @ Find & Ful )\ Localize @@ ShowinVX g F ¥ w ®7
Layer W AL View Q[@):# i3 Gt B S o ” Y Y wingn S B
b E Remove Layer + | Previous [P Next + B Rectangle ) Deselect All . Z % cllel = T &
Layer | Navigate | Select | Edit ‘ WinCan | Measure |

inCan Observations

WinCan Inspections

\winCan Manhele Observations
WinCan Manhole Inspections
[] WWinCan Manholes

\WinCan Sections
biel_manholes

biel_section

biel

EEIE

X: 585,277.94 - Y: 220,562.03

The software then is going to filter the highlighted sections and shows you the result in WinCan VX:

I= WinCan VX (-STAGE-) v1.1.2016.0037 [Admin] - [Test_US_PACP]
Projects  Printing  DataExchange | Tools | Views  WinCanAnalyst  Extended Modules Work Order Management
7. ] Quick Filter Map Section ~| User Filter /‘
A 2% i W s W [d 7
@ Available criteria | 11 - b O
Autocreate  Combineabandoned Insertnew WinCan  ManageWeb  Pro Project = _ Searchand Misc.
laterals inspections. manhole  Validator Projects>  Touch | Documents || Apply Filter Y Apply UserFilter  replace Tools ~
Tools Reports | Filter Miscellaneous |

» Work Order "Job 17, Number , Alternative "Variant 1"

Test US_PACP | Sections Laterals MNodes

Pipe graph 17 X ||Sections
'Pipe Segme + “__m _mm_“
ER CD 4 71.10 Haggerstone Place i63 511 Concrete Rectangular 1450/ |
cd 1 28.60 Fairclough Street 3421 3422 Cen tubes Round 400/0
3 cd2 13.00 Fairclough Street 3422 5004 Concrete Round 300/0
4 CDS5 19.00 Lacon Terrace 517 5341 Concrete Horseshoe 1450/800
5 CDEB 83.70 Haggerstone Place 5341 516 Cement Round 1450/800
6 cd3 13.00 Fairclough Street 3422 5005 Concrete Round 300/0
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Vice versa filtered sections in WinCan VX can easily and quickly be shown in Map-VX. Enter the desired
criteria via the filter function of WinCan VX...

u = WinCan VX (-PROD-] v1.1.2017.3 [Admin] - [Test_US_PACP]

- Projects  Printing DataExchange | Tools | Views  WinCanAnalyst | Extended Modules Work Order Management ~ Macros
7. ] Quick Filter Street «| User Filter >
Az % W w a @ KR 7

Avsilable Criteria | | Name: Default section
AutoCreate  Combine Abandoned  InsertNew  WinCan  Manage Web Project

Search and Misc.
Laterals Inspections Manhole  Validator Projects ~ Documents ¥ Apply Filter ® Apply User Filter Replace | Tools ~ |
Tools Reports Filter | Miscellaneous |
? Work Order "-Job 1-", Number , Altemnative "Variant 1"
Sections
Pipe Graph 7 X ||Sections X
5343 Hometawn East End Road Concrete
2 i
O 3 1SWDFA3 . Hometown East End Road 89 > & Concrete
000
4 1SWDFAS Hometown East End Road 84 S 5420 Concrete
5 1SWDFA1 Hometown East End Road S0 = 93 Concrete
= 6 1SWDFA4 Hometown East End Road 88 2 8 Concrete
0
...and the software subsequently is going to highlight the filter result in Map-VX:
wR®eBR - WinCanMapVX - Test_US_PACP = m] K
‘ Home Tools Window @
= @ D Zoom @ Find @ Ful o ®\ Localize @) Showin VX %\ &% W &y
e A Add Layer i @l{é} {3 Selected o €. Point Q. Circle T e - Wit '@\‘ s B
- & Removelayer ~ | Previous |P> Next [H Layer + B Rectangle ) Deselect All S AR A C’l(:l v & &
Layer Navigate Select Edit Wi Measure

[+ WinCan Manhele Parts

[ WinCan Observations

[] WinCan Inspections

[ WinCan Manhele Observations

[] WinCan Manhele Inspections
[] WinCan Manholes
‘WinCan Sections
biel_manholes

X: 585,176.58 - Y: 220,311.09
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7. Show inspections in Map
Once all sections have been transferred from Map and inspected in WinCanVX, the observations for

each section can be visualized at any time when hitting the button .

Map directly shows the highlighted section (1) in WinCan VX. The blue circle (3) represents the current
observation and jumps from one damage site to the next when scrolling up and down with the slider
(3) in WinCan VX or switching to the next/previous observation line:

o WinCan V€ v0.6.2014.161 [Admin] - [Metrapalis_EN_Map |\ WRC_MSCC-3_ENG_UK_SEC/WRC_MSCC-4] c@z
BBl -or Tl viewm  WinCandwst Boended Modiles s
-
=
SwmOS
New Open efresh Mamage | dtfor umen
roiect project oo projeds  provet
o Heta dots
Manholes |
¥ x [[Photavideo 7%
52 Halsfrods METROPOUSMETROPOLIS 280003384 @ 260193383
4626 Am Klgisinger METROPOLISMETROPOUIS 280211756 - 260211755 500
am AmKlsisnger  METROPOUSMETROPOUS 260211755 % 260211754 500
1657 AmKlsisingsr  METROPOUSMETROPOLIS 260211754 9 280201753 500 —
1929 AmKisisinger  METROPOUSMETROPOLIS 200212413 & 222 500 n
n2 26 AmKieisingsr  METROPOUSMETROPOLIS 260212148 & 26020207 500
106 280211730 390 Am Kleisinger METROPOLISMETROPOUIS 280211730 & 280211729 500 -
107 eI ATss Am Kisisinger METROPOLISMETROPOLS 280211728 & 260211726 500 wln can Vx
108 w2172 287 AmKleisingsr  METROPOUSMETROPOLIS 280211752 @ 260201726 500
08 e 152 Halsfnode WETROPOUSMETROPOUS 200001772 & zonm 00
a0 mTm 6w AmKisisingsr | WETROPOLSMETROPOUS 260211773 % 2000172 500
S 22 4 ot 1696 AmKlsisinger  METROPOUSMETROPOUS 280211728 & amenner 500
M2 @y 167 AmKisisingsr  METROPOUSMETROPOLIS 260211727 9 280211726 500 o
8|7 [%|alaX
Sections | Documents | Gecmetry | Hislory | Ratings ﬂ
Observations. - - B
1 100 BCOXP  Rohranfang O . ©  o00uts
2 or BCAAA  Anschiuss Abzweig, offen, 150mm hoch, 150mm bred, bei 9 Uhr . B s o00ta7
— I 4 " BCASA  Anschiuss: Abzweig, offen, 150mm hach, 150mm brsd, bl 9 Uhr ° 5 © 000500 I
6 an BCARA  Anschiuss: Abzwaig, offen, 150mm hoch, 150mm bred, bei 8 Uhr . D e onTt03
7 4928 BCEXP  Rohwends . . o o1t
d
wikwEI: WinCanMapyx
w File Home  Tools | Window
- [ ReceiveMessages -1
= ) .
| Beep #% to Layer | SendMessages feeis | Show Output Extent
Connect Network Network | _ EITTES
[ Show Position | ‘M to WinCan B @] Show Position B =1 Print
GPS 5 | Network | output |
= ¥ Manholes
Ll

[ Base Sections
= [¥| Chservations
.

- v Sections.

o
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8. Edit object layers

Map allows the edition of all objects which have been transferred into WinCanVX and are shown
accordingly on the Map interface So after finishing the survey of all transferred sections the operator
will be able to export corrected or completed geographic data to the client (engineer offices, water
authorities, construction officials etc.) who can directly import and thus easily update their GIS
database.

New or existing objects can be drawn or moved inside the corresponding object layer within Map by
means of the command group Tools > Edit in the ribbon bar:

ﬁ‘ i EditShape ®° Draw Polygon A- Split by Line

‘:,;; Draw Point “ff Draw Circle Snap to |DXF-Plot_ Town -
- # Draw Line®®¢ Draw Rectangle €3/C | °

0 Edit

1. This arrow button lists all commands for the edition of object layers.

2. This function is activating the edit mode for object layers.

3. This group is providing all the tools for drawing new objects (points = manholes; lines = sections;
polygons = building outlines etc.).

4. This field is used to indicate which layer the previously drawn object should snap to: a manhole
point thus should precisely snap to a section line or a reference line on the DXF-plot and vice versa.

The following chapters are going to describe in detail, what the operator must do, if he is going to
discover a new object (e.g. manhole) or if he wants to change the position of and existing object or
delete it from the map interface.
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8.1 Creating new objects
In order to have new objects (e.g. manholes) created, Map provides two possibilities, that are described

and illustrated in this sub-chapter:

Follow the steps below to draw new manholes directly on the map interface:

1. Select the layer WinCan_Manholes.

2. Hit the button Draw Point.

3. Select the DXF-plot with the reference lines the new manhole should snap to.

4. Go to the desired position on the DXF-plot and draw the manhole hitting the left mouse key.

5. Enter the name for the new manhole in the dialogue that pops up and confirm it:

wil=®BIl- WinCanMapVX - Test_Map_EN X
Home Tools Window
@ 0= Eopt  m w X
s [ Show Position & Export DXF N;;;rk % Show Remediation Data Emm [ Show Output Extent f Draw Point Qf 070330Pipelines - 3
Settings 2% To Layer ‘W ToWinCan | € TfL Export s Print +  Z Drawline ¥ (+@
GPS Export Network

| Dutput Edit | Back... |

winCan Manhele Parts

WinCan Observations
WinCan Inspections
WinCan Manhole Observations
winCan Manhole

= [2] WinCan Manholes

®  Other
con 0
@ noD
[ WinCan Sections X [5753316% H D

DXF-Plol_Town Y [19719401 H
070330PipeLines -

5 MH_003

~~ MH_DD4

W Node Details

Node Reference

ME_001 |

Coordinates <

z [o.000 B

w001 Atributes
Type |Drainage Assst b |

Node Type

|

Wal Mateial [
Invert Depth (m) | |

|

|

Owner

Use:

Remaric

10
8- Be-
X: 575,331.79- Y: 197,194.19 e

6. The coordinates are taken directly from the DXF-plot and written into the coordinate fields in
WinCanVX:
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Follow the steps below to draw existing manholes on the map interface:

1. Enter the manholes in WinCanVX, switch to Map and select the layer WinCan_Manholes.

2. Hit the button Draw to get the drawing panel shown on the right of the Map interface (4) and

activate the button Draw Point.

3. Select the DXF-plot with the reference lines the new manhole should snap to.
4. Go to the drawing panel, activate the tab Manholes and grab an existing manhole from the list.
5. Go to the desired position on the DXF-plot and draw the manhole hitting the left mouse key.
6. Confirm the manhole position in the dialogue box that follows:
MY WinCanMapVX - Test_ Map_EN
Home Tools Window @
@_ Besp B Export = |Ux ConnectWinCan VX | i & EditShape ® 5{
— Show Position ‘é» Export DXF N;t:v- X :— Show Remediation Data F_x-t ‘ n Show Qutput Extent *# Draw Point |®7|070330Pipelines -
Settings 2% To Layer # ToWinCan | € TFL Export . = = Print # Drawline W c:é@
GPS Export Network Output Back...
Layers o X p—g R Drawing nx
[] WinCan Manhole Parts Draw Manholes  Sections
winCan Observations MiHon0
WinCan Inspections -
WinCan Manhcle Observations # Node Details MH_012

WinCan Manhele Inspections

(=l [] WinCan Manholes

®  QOther
CON

@ nNOD

winCan Sections
DXF-Plat_Tawn
070320PipeLines

X: 576.351.22 - Y 187.220.80 o

7. The coordinates are taken directly from the DXF-plot and written into the coordinate fields in

WinCanVX:

Node Reference

Coordinates
X 575351223

Y 197220619
Z 0.000

Attributes

LERECRES

Type |Dmmage Asset

Node Type

Wall Material

Cwner

|
|
Invert Depth (m) |
|
|

Ok

m Cancel
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8.2 Displacing or deleting existing objects

The following example shows how one can displace or delete an existing manhole on the map:

1.
2.

b

Select the layer WinCan_Manholes in the legend

Go to Tools > Edit and select the corresponding DXF-layer (2) the manhole should snap to from the
list box:

%‘ @' Edit Shape ® Draw Polygon % Split by Line
- *# Draw Point ® Draw Circle Snap to |070330Pipelines -
raw

- # Drawline B Draw Rectangle C:I
| Edit |

Hit the function button Home > WinCan > Shift.

Click directly on the manhole to be displaced, drag it to the desired position (4) keeping the left
mouse key pressed. The manhole is then highlighted with a red circle representing the edit mode.

Release the left mouse key as soon as a red cross highlights the desired position the manhole should
snap to.

w! i - I= WinCanMapVX - Murten - m} X
Home Tools Window @
ﬁ M Add Layer i Export B Zoom @ Fnd @ nR% y ? ;J:
Layer E Femove Layer ié. Eport DXF View u! Fan Q':" '; Select & lli B ':if'\' Rotate \?)'. “ LY
- © Til Export + | Previous | Next :,": = q; o WinCan . -
Layer | Export ‘ Navigate Select | - J'ﬂn Rotate Scale VX d/:

WinCan
winCan Manhele Parts |
‘winCan Observations
‘WinCan Inspections
‘winCan Manhole Observations
‘winCan Manhele

=)

ViinCan Manholes
®  Other

CON

@ NOD

WinCan Sections

DXF-Plot_Town
070330PipeLines

X 575,368.81-Y. 197, 21256

Mind that Map does not automatically drag a linked section line to the new location of the manhole.
So you have to repeat the steps above and move the section to the new manhole position making sure
the section line snaps to the layer WinCan_Manholes.
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In order to delete an object, select the corresponding WinCan layer (1), activate one of the selection

tools (e.g. Home > Select > Point) and click on the object to be deleted (2). Next switch to Tools > Draw
> Delete Shape (3):

wl®El- WinCanMapVX - Test_Map_EN - o x
Home Tools Window @
@_ | Beep B Export r!_‘- % Connect WinCan VX "; g\ & EditShape ® 5
| Show Position & Export DXF % Show Remediation Data "™ O] Show Output Extent *# Draw Point #7|070330PipeLines -
GRS Network Extent Draw Tiles
Settings 5% To Layer W ToWinCan | € TiL Export ® Show Pasition iS4 Print - | Dewline ¥ cffc])
GRS Export ‘ Network | Cutput ‘ End Edit ‘ Back... |
UndoEdit  Carl=U
[] WinCan Manhale Parts e R
2] WinCan Obserations RedoBdit  CwieR
[] WinCan Inspections )

[ WinCan Manhcle Observations
] WinCan Manhole i
=[] WinCan Manhales

®  Other
CON
® NOD

] WinCan Sections
[] DXF-Plot_Town
[v] 070320PipeLines

X:575,375.31- Y- 197,217.39
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8.3 Modifying the geometry of existing pipe sections

WinCan Map draws a section always as a straight line per default. When the operator has to enter a pipe
bend at a given position, the corresponding observation will appear on the inspection protocol, but
Map still shows it as an observation point on a straight line.

In order to have pipe bends shown on the Map as close to reality as possible, you can edit the section
and re-draw the pipe course taking the objects of the background plot as a reference. The steps below
describe in detail how you must proceed:

1. Highlight the layer WinCan_Sections on the legend.
2. Select the section whose course you want to re-draw.

3. Activate the command Tools > Edit Shape.

%\ & EditShape ® Draw Polygon

"# Draw Point @7 Draw Circle
Draw
+~ |# Drawline B Draw Rectangle

Edit

4. Grab the section at a specific position (e.g. observation point describing a pipe bend) and put it to
the desired location via Drag & Drop. You can either confirm or decline this change via the context
menu command End edit or Undo edit:

" I 4 F| I's WinCanMapVX - Murten - O

Horme Tools Window

@ Beep # ToWinCan LB %{ Connect WinCan VX Fa] Show Qutput Extent ﬁ‘ & Edit Shape | ® Draw Polygen - Split by Line
Show Paosition o 5 Show Remediation Data o #=x Print *# Draw Point ® Draw Circle Snap to -
GPS Network — Extent Draw
Settings 2 To Layer ® Show Position « # Drawline ¥ Draw Rectangle C}|C:|
GPS Network Cutput Edit
Layers aox|l N g -
[] winCan Manhole Parts N N
‘wfinCan Observations S A
‘wfinCan Inspections N %
‘winCan Manhele Observations b, N
‘winCan Manhole Inspections h, N
=[] WinCan Manholes N N

®  Other A

.
CoN o S

@ NOD 7 "
i 7 End Edit
‘wfinCan Sections 4

[ 070330PipeLines v Cancel Edit
=[] DXF-Plot_Town 4

0 Undo Edit

01619 )

5 otet Redo Edit

0218
01211

P

5. Repeat the last step as many times as you want in order to displace further section points.

6. Hit the context menu command End edit to confirm the new pipe course or hit Undo edit to decline
all changes and reset the section line.

This finally gets the pipe bend represented on the background map as close to reality as possible:

Page 35/48



Edit object layers

In case the result is not satisfying it is always possible later on to reset all the edits you previously did
using the command Home > WinCan > Reset transformation. So the pipe course you have modified
manually again becomes a straight line:

R wmE - WinCanMapV% - Murten
File Home Tools Window - =
P p &b Shi 4 e

= | Addlayer @ Export D Zoom @ Find @ Ful €. Localize B Rectangle ¥R SelectAl I 2" Shit 8 iy

= B Removelayer | Export DXF =3 [@] @923 Selected €. Point T Polygon I} Deselect Al @ Rotate T &
Layer View Select WinCan

< © TiL Export - ol Previous | Next  §7) Extents - G Circle @) Showinvx % Rotate Scale W ﬂ

- e
Layer Export Navigate Select o Measure

Layers ax N '-m Edit Mapping

WinCan Marhole Parts o i

\finCan Observations Transfer to WinCan

VfinCan Inspections
\finCan Manhole Observations
VfinCan Manhle Inspections
= [ WinCan Manholes

Reset Transformation

®  Other
CON
@ NOD

winCan Sections
[] 070330PipeLines
= f] DXF-Plot_Town

0

01619

L

01219

0211

BCazil
BOEAH
/247
BoDA
&
BCD 1

< >
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8.4 Measuring distance between two reference points

In case you need to verify a section length, you can directly measure the distance between two
manholes using the ruler tool (1). Just click on a start point (2) and drag a line to the end point (3). The
distance is continuously calculated and displayed in the status bar on the left (4):

Select WinCan

wh®H = WinCanMapVX - Test_Map_EN - O x
O Home | Tools  Window B
o @ D Zeom @ Find @ Full e € Localize T Rectangle W @ﬁ,
ek € poi = 5 .
o 9 Add Layer v U Pan- @ [@]:8: (3 Selected i TR POt Sopohgon  Ho :, e " Length: 34.471
- | RemoveLayer | Previous [P Nex > R e ¢.| ) Area - |

L7 Layer ‘ - G Cicle @) Showinvx i

Layer Navigate Measure

4] WinCan Manhole Farts

[#] WinCan Observations

[ WinCan Inspections

[ WinCan Manhole Observations
[ WinCan Manhole
= [ WinCan Manholes

®  Other

CON

@ nNOD
[ WinCan Sections
[ DXF-Flot_Town
[ 070330PipeLines

X: 575,396.91 - Y- 197.232.16 Lﬁ'gth: M4BT m I"

Right click once on a blank spot on the map to stop the measurement:
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8.5 Getting manhole positions via GPS receiver

The map section can also be coupled with a GPS device (GPS = Global Positioning System). For that
purpose a GPS device compatible to the standard NMEA 0183 has to send the current position
constantly to the COM port of the computer it is connected to.

Click the button to make appropriate settings in the working panel that subsequently pops up:

oii B WinCanMapVX - Bad_Oeyshausen
riie [

L

=% Warkolen v —

jagend % L G
®

Specify which coordinate system the GPS device would need to refer to for the output of the position
data. If ever possible choose a globally valid coordinate system such as WGS 1984 (WGS = World
Geodetic System 1984).

Once the GPS device has been set correctly the operator is going to the spot where the manhole is
located and is reading in the position data received directly by the device at that specific location.
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8.6 Setting manhole positions with reference circles

In case a GPS device is missing or providing inaccurate position information the exact manhole position
can also be calculated with 2 reference circles. If the aforementioned manhole has not been drawn on
the plan you will have to measure the distance between a known start point (e.g. building corner) and
the real manhole position.

Subsequently create a new polygon layer (e.g. MH_ReferenceCircles.shp (1)) and draw the required 2
reference circles using the button as shown below. The centre of the circle always corresponds to

the start point of the distance measurement (1a and 1b) and the radius is always equal to the previously
measured distance between start point and manhole:

ol N = WinCanMapVX - Murten
Home Tools Window
= @ @ Zoom @ Full o ‘p Localize rp\ Polygon %‘ ﬁ' Edit Shapgp =raw Polygon
Add Layer & | pan :;. Selected "} Point C‘} Circle - '//‘ Draw Paoil rav-' Circle Snap to | MH_ReferenceCirc ~
La V = Select | b Shape 5 y
Remove Layer | Previous | Next Layer - b Rectangle ) Deselect All o # Drawline - Split by Line C:é@
Layer Mavigate Select Edit

Legend

¥ MH_RsferanceCircles
W mugten_manholes
] situation

v seclions
XF_Plot

Circle Radius

Erter Radius in Map Units
J60

Gircle Radius

Erter Radius in Map Units
48l

Finally switch to the manhole layer (2), add the missing manhole with the button attheintersection
point of the two circle lines (3) and note that the new manhole must precisely snap to the layer
MH_ReferenceCircles (i.e. the intersection point).
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9.Using map tiles from an external service provider

For better spatial orientation a geo-referenced satellite image can be used as a background layer and
move the project data perfectly to the corresponding geographic region.

In most cases such map data are not provided by end customers, so WinCan Map allows the user to
connect to the external service Microsoft BING Maps.

First run the command File > Projection System to open a list of all worldwide used coordinate systems
(projection systems) among which you will also find the one valid for that region where the current
pipeline network is located:

BRI -

ay)
m

New Project D:\WinCan_Projects_TEST\Test_...\wxproject.ttkproject

Open Project

il

Save Project

= . . A
.0 Save Project As Coordinate System x
Settings (® Projected system:
GDASE MGA zone 55 (g ~

GDAJ4 MGA zone 55 (epsg:
GDAS4 MGA zone 56 (epsg:28356)
GDAS4 MGA zone 57 (epsg.28357)

Mo £Xx

Print O

EPSG I — GDAS4 MGA zone 58 (epsq:23358)
) o (O |GDAS4 MGA zone 59 (epsa:6738)
GDASS NSW Lambert (epsg:3308)
. GDAS4 SA Lambert (epsg:3107)
I} et DA Viegnd (epsg:3111) vE

The list box depicted above shows a group of coordinate systems which are valid for Australia.

Information about the currently used projection system can be obtained from the properties dialogue
of the original SHAPE layers:

Layers X
[ WinCan Inspections
[] WinCan 3D Measurements Vector: Tatura Sewer Mains 3-8-2016 X
EI[] \WinCan Hodes + = |X w &  Paameters I I
o oner Fan
cON Sections |C “WinCan_Projects\DEMO_AL_WSA_2020"Module’\MapTatura Sewl
o =l Section 1
Renderer Hame
@ o Line [Tatura Sewer Mains 382016 |
Qucogeens o
wlinCan Sections & Laterals
et o Nt 22018 D [Tatura Sewer Mains 38201
Tatura Sewer Mains 3-8-2016 Coordinate System
|GDA‘34 MGA zone 55 (epeg:28355) Select
Painting
[] Basemap Transparency
Cached Paint

Ignore shape parameters
[] Muttipass rendering

Scope {must be logical)

Prefer styling from config file

Agaregation
= & Method v

If the projection system which the manhole and pipeline layers are based on is unknown, you will have
to ask the engineer office for the EPSG code of the correct projection system.
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Next select the tab command Tools > Tiles that opens a working panel on the right side of the main
screen. The user is able now to access directly to the map material provided by the Microsoft BING file
server. Therefore select the map style (1) before you click on the button Add Layer (2):

viRER: WinCanMapVX - vxproject

Home Tools 3D Measurement Window 2]
@ O Beep m TR ConnectWinCan VX| {8 Export I’;'i [ Show Output Extent E L2 Ruler 2 Measure Polygon ®

ol
- —_ . r . . A
[ Show Pesition + Show Remediation Data | ExportDXF  ©— 7' | J& Print O Measure Circle
GPs Network 3 t

ten Tiles
Settings

® Show Position 4, TEL Export Profile [ Messure Rectangle
GPS | Network |  Export | Output | Measurement |  Background Tiles |

[] WinCan Inspections ~
[] WinCan 3D Measurements TieLayer
&[] WinCan Nodes

@ Other

o CON

@ noo 11128
[] WinCan Observations

Map Style

[] WinCan Sections & Laterals Canvas light
Tatura Sewer Nodes 2-8-2016 Canvas dark
Tatura Sewer Mains 382018 Canvas gray

Caching
[ Work Offine

|C:\WinCan_Projects\DEMO_AU_WSA_21]

[ Select Cache Folder .

< >

X:340.660.18 - Y: 5,965.619.77

WinCan Map will zoom the background layer directly to the spot where the pipeline network is located:

wi ‘: E E '3 WinCanMapVX - vxproject

Home Tools 3D Measurement Window @,

@ 1 Beep ‘?‘ |[G% ConnectWinCan VX] 8 Export fi‘i Show Output Extent 2 Ruter © Measure Polygon “@,
=
| Show Position | = Show Remediation Data  Export DXF b & Print Q Measure Circle “aa
GPS Network | Extent o Tiles
Settings |[@ show Position 4 TiL Export Profile \3. Measure Rectangle
GPS | Network Export | Output | Measurement | Background Tiles |
[ WinCan Inspections & q "
[] WinCan 3D Measurements ) oy [ebey
&[] WinCan Nodes
[ Wincan 66 { y Remove Layer
@ Other
o con | @ Goto Locaton
NOD
® Map Style

[] WinCan Observations

[ WinCan Sections & Laterals
Tatura Sewer Nodes 3-8-2016
Tatura Sewer Mains 3-8-2016
Background Tiles

Canvas light
Canvas dark
Canvas gray

Caching
[ Work Offine

[C:\WinCan_Projects\DEMO_AU_WSA_2(

[ Select Cache Folder

X: 340,494.17 - Y: 5,965,809.70

Mind that you will need a powerful internet connection to make full use of the Microsoft Bing Maps
service.
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10. Visualizing Map topics (predefined queries)

Open WinCan VX and select the command Home > Settings > Thematic maps. Assign a Map topic of your
choice to each predefined VX query:

W WinCan VX Settings

Topic Thematic maps - Assignment of VX gueries to Map themes
General WX query | Map theme |
meien Damage classification Damagellassification

Inspected / Uninspected InspectedUninspected
03D Material Pipe materials
Speech Pollution types

Profiles Profiles
Keyboard entry Type of pipes/nodes
Thematic maps \nwiater protection zones

Year built YearBuilt -
Presets

DamageClassification
Inzpectedlninspected
Fipe matenials
Profiles

The user will be able from now to call up the chosen topic in WinCan VX for the current project when
selecting the corresponding query listed in WinCan Analyst > GIS query. There are currently 8 topics
available which are briefly described below:

1.

Classification of damage (DamageClassification):
Displaying and labelling all sections according to their damage classification using default colours.

. Inspection progress (InspectedUninspected):

Query for the inspection progress. WinCan VX handles a section as inspected as soon as it contains
at least 2 observations.

Pipe material (material):
Displaying and labelling all sections according to their pipe material using default colours
(concrete, PVC, steel, etc.)

Purpose of the pipe line (pollution type):
Displaying and labelling all sections according to their purpose (waste water, rainwater, mixed
water etc.).

Pipe profiles (profiles):
Displaying and labelling all sections according to their profile (circle, egg, rectangle mouth etc.).

Type of pipe line (type of pipes/nodes):
Displaying and labelling of all main and lateral pipes (house connections).

Protection zones (water protection zones).
Displaying and labelling the location of all pipe lines regarding to water protection zones.

Year of construction (year built):
Displaying and labelling all sections according to their year of construction using default colours.
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11. Thermographic visualization of defect density

The objects or damage images of the project can be illustrated according to their density as

thermographicimage. Red is representing areas on the map with high, Blue those with a low object or
event density.

First select the layer (e.g. observations/damage sites) whose object density you want to show on the
map (1) and click on the command Home > Heat Map. In the subsequent dialogue window you must

set the size of the field grid as well as the search radius [m]:
winwE:

WinCanMapVX
Home | Tools  Window
2 zoom & Full ®) Localize ¥ Polygon i EditShape ® Draw Polygon /7 shift %/ Send Map Position
& W Add Layer & {3 selected o . point Q. Girde W‘ %/ DrawPoint ® DrawCircle | Snap to - v 7+ Rotate 9, Position WinCan
e | & Removetayer | V=" |l Previous 1D Next | B Layer | % | Rectangle S Deselectall | T | 2 Drawtine 3% spiitbytine | @€l Winkan | /2 Rotate Scale @ Heat Map
Layer ‘ Navigate Select | Edit | WinCan |
[ Manholes Heatmap Analysis E
.
e 1 N o
5 B Sectians MName:  Observations
P
= W Layor il
ZCl [~ Selection Only (Subselect)
— )
o258 [ Settings
1 s e
B son1sr
a5 575 Cell Size [map units] |5
P
easas2
= o] Search Radius |125|
o
Bt ¥ Treat Zero as NoData Value
r— Use Field
I<caunl> j
|—0Llp|l(‘:id Name
| |
A larger search radius reflects the large
scale distribution of observations.
Select _Zoom Ok Cancel
IwRwE - WinCanMapVX
Home Tools Window
£ zoom @ Ful *) Localize %} polygon 4 & Editshape % Draw Polygon £+ shift /" send Map Position
= B Add Layer @ (& Pan] £} Selected 0 . Point G Cirde ﬁ % DrawPaint @7 Draw Girde | Snap to v /+ Rotate 9, Position WinCan
e & Remove Layer ‘ e | Previous | Next | [ Layer ‘ Sa‘fﬁ ¥ Rectangle €). Deselect All Sh,a“ # Drawline 3 splitbyLine | €4|e]
Navigate

/% Rotate Scale % Heat Map
Select Edit WinCan

10852
B e
[
[
T Basa Sections

Search Radius [2

¥ Treat Zero as NoData Value

i Use Field

J<count> |

r&lptl(‘iidﬂam

=

|
A smaller search radius sheds light on the
small scale distribution of observations

and thus provides a more accurate
analysis.
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Thermographic visualization of defect density

In case the colour gradients should be displayed rather smoothly choose a small area grid which
however should be at least 2 m. The display of areas with even smaller grid sizes takes much more time

and is recommended only on computers with appropriate CPU power and memory size (corei5, 8GByte
of RAM, 64 bit operating system).
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Printing data

12. Printing data

The geographic data can be printed directly in Map-VX where you may choose among four built-in
printing templates. The print-out is done via the command Tools > Output > Print.

In the following dialogue box the user can finally specify the extent of the map section to be printed.
Hitting the button Visible (1) returns a print preview of the currently visible area in WinCan Map, the
button Output (2) zooms the preview to the predefined output area.

vih BRI WinCanMapVX - vxproject

Home Tools 3D Measurement Window

@ | Beep ﬁ Connect WinCan VX E Export L3 Ruler O Measure Polygon RS
| Show Position & Show Remediation Data = Export DXF O Measure Circle Ik
GPS Network Ext Tiles
Settings @ Show Position 4 TEL Export Profile E Measure Rectangle
Measurement |  Background Tiles ‘

@ [] WinCan 3D Measurerr\ems
=[] WinCan Nodes

@ Other
O CON

@ NoD

[J WinCan Observations

[J WinCan Inspections

[] WinCan Sections & Laterals
[V] Tatura Sewer Nodes 3-8-2016
[ Tatura Sewer Mains 3-8-2016
Background Tiles

W Print Preview

Bl g 2y |7

* Print Setup | Print

‘|

W Print Preview =TT
= 3|/ Select Template Simple.tpl -\ TR
Print Setup | Print Visibi ¥
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Printing data

The field Select Template allows the user to choose among up to four predefined printing layouts:

W Print Preview - (] X

Vs re=a  r—na FES -~
E Q IL[JI 1% = Select Template H [_é ‘ J

* Print Setup | Print

Hit the button Edit Text to write yourself a map title and select the template WithLegend to include the
legend in the printout.

W Print Preview - m} X
;= re=a  r—na FES s ‘
g Q IL[JI 1@ ] b Select Template |\WIIEELERE) B U Edit Text J
¢ Print Setup | Print Visible | Output A

Tanura Sevar Nodes 352016
°
Tatura Sewer Mair 382016

Backgrourd Ties
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Exporting data

13. Exporting data

Before exporting data via Map-VX the user must define an output area. This is done via the command
Tools > Output > Show Output Extent. Click on the button Extent to display the working panel with all
the output options below the legend:

rEER WinCanMapVX - vxproject - [m] X
Home Tools 3D Measurement Window @
@ | Beep ‘T‘ ;‘)’( Connect WinCan VX E' Export |;1| ¥| Show Output Extent I u Ruler ,Q_ Measure Polygon \©’
A
Show Position 3 Show Remediation Data | Export DXF ot w3 Print O Measure Circle S b
GPS Network | Extent Tiles
Settings i\')rsrhoyv Position 4\ TiL Export] Proﬂle Q Measure Rectangle
GPS Network Export Output Measurement Background Tiles
1
Layers K 107515 107498
£ [ Tatura Sewer Nodes 3-8-2016 s i
® =

E [V] Tatura Sewer Mains 3-8-2016 i

Troon Ct

107497 107536

Background Tiles

Cussen Park

=1
3

144903
[
107414
&= . M ] 107538
L gy ) g [
14.37‘4 5 ‘
lams: 196358 o g g 107425 %
O Ty g e
— s & 107539
- 1 107423
i 1@ 1R 11 N niever Tatura 3y N
S Tt S iy SR A A 107419 §
Current Extent g o]
107433 107432 pgrg, 4y 107431 S 107540
5966426.72419401 L 2
o
[341460.237137046 |[341707.11856472 | 2
5966300.4531864 ( 8 ) iz 107410 L

Nardoo Ct
Show Output Extent in Map

107408
(] 3
£ 107393 107553 107('\550
107403 i 4 [
2 105-%94 107554 Lions Park Ii.

To define the output extent for further data export the user has got 7 possibilities available as icon
buttons which are explained in detail below:

i'_'l 'II'_'I "l "l

-IH =I-|| Ll

oRoRoXoROROLO}

1. The map area with the selected objects is exported (see illustration above)
2. The currently visible map area is exported.

3. The WHOLE map area is exported.
4

. Free selection of the export area: The selection rectangle will snap to the predefined coordinate
points (8).

(%)

. The data layer currently selected in the legend is exported.
6. The current view zooms to the selected export area.

7. Free selection of the export area: The selection rectangle ignores any coordinate points. The
selection of an empty map area is automatically adopting the data field structure (without content)
of the currently selected layer. So the existing attributes of a section layer may easily be transferred
to a new layer for lateral sections (satellites).

Always activate the check box Show Output Extent in Map in order to display the red frame around the
map area that corresponds to the preferred output.
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Exporting data

Once selected the user can export all objects (sections and manholes) inside this map area via the
command Home > Layer > Export:

vihER - WinCanMapVX - vxproject - u] X
Home Tools 3D Measurement Window @
’ Eo Add Layer @ D Zoom Q { 5 @ Full @ LN Object G Polygon Z/‘ % Draw Point -F/‘/‘ @ }j g ” \:"X ﬁ
B Remove Layer Q 4y Pan| ® Find [l Selected G, Circle B Select All & Drawline 7 @& 7+ €l : o
Layer View S0ES Select - Draw A A : WinCan __
v v 4| Previous [P Next 7 Extents + D) Rectangle ¥k Deselect All v ¥ DrawCircle S & @ | Co - b4
J a Add Layer from Intemet h — Navigate Select - L Edit 1L '*uu’sr:'a\g\onu'uu'"* WinCan B
I8, AddLaer fhid
107!
B Remove Layer . barsa . 107 e
E’o Add Layer Vivax CSV
E’o Add Vivax Layer From AP ' 11?”
e s ORI Sl N fiteys
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rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr cope
Q Show Layer Properties
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New et 7 (O Use Full Extent
Guo' Import GeoDatabase @ Use Output Extent
@) Import Shapes [] Clip Shapes on Extert Fe|
‘ H‘l Restructure Layer
By Sovelayer Projection options
O RevertAll | | | I
‘ ﬁo Export
‘ Export DXF
5965847.43138641
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fe, Milk
[ Show Output Extent in Map 107689 iz5a71€S o
1076%0 © &=
-]
o
=
2
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Select the second option in the dialogue box that follows, if you have already set an output area before.

Activate the first option, if you don’t want to set any limited output area and prefer to export all
available objects (sections and manholes) which are shown on the map.

Subsequently the exported data can be saved in the file formats SHP (SHAPE fomat), DXF (AutoCad
format) or CSV (MSExcel compatible).

&«

Organise = Mew folder fz o

# Save As X

- C:\WinCan_Projects\DEMO_AU_WSA_20204Misc\Exchange} ] Search Exchange el

DEMO_AU_WSA_2020 (o) MName Date modified Type
DB
Misc

Map 14/02/202414:07 File folder

Backup
Docu
Exchange
Logo
Report
Transfer
Module
Picture
Trash
Video
WinCanVx

Haldenstrasse
v £ >

[ T A T X TP VI T

File name: | TaturaSewer_EXPORT w

Save as type:

DXF File (*.dxf)
CSV File (".csv)
~ Hide Folders KML File (*.kml}

TAB File (*.tab)
GeolSON (json)
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